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Using PantoneLIVE Plugins in Adobe® lllustrator®

PantoneLIVE Color Book and Viewer is a set of Adobe® lllustrator® (5 minimum) plugins that
allow direct selection of colors from PantoneLIVE’s collections and subsequent on-screen
rendering of colors within the context of a design. Proofing to a supported PantoneLIVE proofing
solution yields hardcopy proofs of the final design.

The PantoneLIVE lllustrator plugin acts as your gateway to the PantoneLIVE Cloud when using
Adobe lllustrator. This utility ensures you are using the most up-to-date, color PantoneLIVE
libraries directly within the software without requiring any additional tools. PantoneLIVE is also
supported in other products to assembile files, separate artwork into channels for production, and
manage workflows including web-based collaboration, as well as render and proof color. Visit
www.xrite.com for more information.

An important first step for color results is creating a color-managed environment. This ensures
the colors you see on screen and in print are the same colors that are intended for output. If
color is important to you, tools such as i1 Publish Pro are recommended either with or without
i1i0 automatic chart reading to color manage your printers, proofers and displays in design,
prepress, CAD and imaging workflows.

© Pantone LLC, 2024 Page 2 of 33
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Getting Started

You must have a PantoneLIVE Application License to access the PantoneLIVE plugins, and you
must activate the license on My X-Rite. Once this is complete, you can download the
PantoneLIVE plugins and access them through Adobe lllustrator. Please have these steps with
you to ensure you follow the process correctly.

Step One: Create a My X--Rite Account
If you already have a My X-Rite account, please skip this section.
1. Go to www.xrite.com.
2. Click My X-Rite from the black bar across the top of the screen.

About Us  Markets Products  Training Services  Munsell News/Events  Suppor My X-Rite  \Where to Buy

Search

3. Click the “Create your account now” link and enter the required information.
4. Follow the prompts to create your My X-Rite account.

5. After your account is created, you will receive a validation e-mail. Click on the included
link to activate your account.

Step Two: Activate your PantoneLIVE Application License
When you purchase PantoneLIVE Color Book or PantoneLIVE Color Book and Viewer you will

receive an e-mail with your PantoneLIVE License information. You must use the link in this e-
mail to activate your license.

1. Click the link to claim and activate your PantoneLIVE license. You will be taken to My X-
Rite.com.

2. If necessary, log in using the e-mail and password for your My X-Rite account.

3. You will be taken to the PantoneLIVE License Management screen, where you can

manage your PantoneLIVE licenses. Your new PantoneLIVE application license will be
listed.

PantoneLIVE License Management

This screen allows you to manage your licenses for PantoneLIVE. Intro text about managing license configurations. This space could be used to explain configuration
options or be left blank. Open field for as much text as is needed.

Thank you for your PantoneLIVE license purchase. Your PLIVE1 Yr Lic +ColBook/Viewer license has been generated and is available below.

+PLIVE 1 Yr Lic +ColBook/Viewer (PLV-CBVNEW) 1 Seats

© Pantone LLC, 2024 Page 3 of 33
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4. You are the owner of the license, but it remains unassigned. Click on the small
downward-facing arrow to expand the license dialog.

+PLIVE 1 Yr Lic +ColBook/Viewer (PLV-CBVNEW) 1 Seats
Activation Code Assigned To Description Expires
ef35f6d8-bSba-472f-bcéf-20a087eabbal Unused 8/22/2013 edit

5. Click on the edit link to manage the new license.

Assign Activation Code

License Info

Application: PLV-CBVNEW
SKU: PLV-CBVNEW
Expires: 8/22/2013

close or Esc Key

Activation Code: ef35f6d8-b5ba-472f-bc6f-20a087eab6atl

Enter the name and email of the person you would like this activation code assigned to.

User Name Message

Email

Confirm Email

Active Description : 2 x P
This makes it easier to manage activations

[JJUse this activation yourself

f <r=ra f s
(Done ) oOr ( Cancel )

You have the option to use the license yourself, or assign it to someone else.

Assign Activation Code

License Info

Application: PLV-CBVNEW
SKU: PLV-CBVNEW
Expires: 8/22/2013

close or Esc Key

Activation Code: ef35f6d8-b5ba-472f-bc6f-20a087eab6atl

Enter the name and email of the person you would like this activation code assigned to.

Test User This PantoneLIVE license is for the Illustrator Plugins

TestUser@email.com

TestUser@email.com

PantoneLIVE License 3 . 5 P
This makes it easier to manage activations

#Use this activation yourself

Enone® ECancel®
((Done ) Or ( Cancel )

© Pantone LLC, 2024
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o If you will be using this license, check the box next to Use this activation

yourself. You may add a description in the “Active Description” field.

If you want to assign this license to someone else, enter their name, e-mail
address, and if desired, a message. The recipient will receive an e-mail with an
activation code, which they must enter when setting up the PantoneLIVE

connection the first time. See “Setting up PantoneLIVE Connection” for more
information.

7. Click Done.

+PLIVE 1 Yr Lic +ColBook/Viewer (PLV-CBVNEW)

Activation Code Assigned To Description
ef35f6d8-b5ba-472f-bc6f-20a087eabbal Test User PantoneLIVE License

8/22/2013 edit

1 Seats

Step Three: Download and Install the PantoneLIVE Plugins

The PantoneLIVE plugins are available for Windows XP and Mac OS.5 and higher.

To Download and Install on a PC
1. Ifitis running, close Adobe lllustrator.

. Visit http://www.xrite.com/product_overview.aspx?ID=1988 to download the software

. Select PantoneLIVE.exe and follow the wizard to install the plugins.

2

3

4. Choose your language.

5. Click Install PantoneLIVE for Adobe® lllustrator®.

 PantonelIVE 1.0 Plug-ins Installati

File Help
QOHKRE®
w 1

lug-ins - .
z,,- = J PantoneLIVE Plug-ins - September 11, 2012
(el
I| =

=
FLIVE

PREFERRED PARTN
SunChemieal
amambercl e OC g0 ey
Software Installation

Please consult the Read Me document for instructions on how to install the software.

See the Release Notes for the latest news about this installation package.

Install PantoneLIVE for Adobe® Illustrator®

© Pantone LLC, 2024
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6. Click Next to progress through the installation wizard, accepting the license agreement

and selecting an installation location. After the files have extracted, accept the license
terms and click Install.

X-Rite PantonelIVE Plug-ins for Adobe Illustrator - Installation = X-Rite PantonelIVE Plug-ins for Adobe Illustrator - Installation =
. Adot i : Way

Welcome to the X-Rite PantoneLIVE Plug-ins for 2cHite kantonol IVE: Plug-ine for Mimtralos - Wataetion 3 .{r

Adobe lllustrator Installation Wizard Hesnes Porsement z 2

E{LIVE

The X-Rite Installation Wizard will install X-Rite PantoneLIVE Plug-ins for

Please read the license agreement, select "Yes, | accept the license agreement’ and click Next to continue.
Adobe llustrator on the system. g cept g

Click Next to continue, click Cancel to quit.

END USER LICENSE AGREEMENT

FOR a
PANTONELIVE SOFTWARE AND PANTONELIVE DATABASE

ACCESS

This is a legal agreement (the “Agreement’) between you, the end user, and X-Rite, Inc.,

a company having a place of business at 4300 447 St. SE, Grand Rapids, M 49512, on
behalf of itself and its Affiliates, including specifically Pantone LLC (collectively, "X-Rite").

BY INSTALLING THIS SOFTWARE PROGRAM AND/OR ACCESSING A DATABASE
MAINTAINED BY OR FOR X-RITE, INCLUDING SPECIFICALLY THE PANTONELIVE
DATABASE (DEFINED BELOW), YOU AGREE TO BE BOUND BY THE TERMS OF THIS Y.

" Yes, | accept the license agreement

" No, | do not accept the license agreement

| Net> | cancel |

| Nex I Cancel |

7. Click Next to proceed through the wizard, selecting the plugins to install and the
destination folder.

X-Rite PantonelIVE Plug-ins for Adobe Illustrator - Installation

= X-Rite PantonelIVE Plug-ins for Adobe Illustrator - Installation =

X-Rite PantoneLIVE Plug-ins for Adobe lllustrator - Installation g;l}? X-Rite PantoneLIVE Plug-ins for Adobe lllustrator - Installation ¥ 'I;TP
Select the X-Rite PantoneLIVE Plug4ns for Adobe lllustrator products to install g [ Select the destination folder(s) for the new components to install g‘ .
FALIVE FLIVE

Select the X-Rite PantoneLIVE Plug-ins for Adobe lllustrator products to install on this computer. Select the destination folder for the new components to install.
The list displayed below shows all the X-Rite PantoneLIVE Plug4ns for Adobe lllustrator products that can be

Select a destination folder for all components or for each component individually. Entries marked in red indicate
installed according to the system settings. Please select the products you wish to install on this computer.

that there is not enough free disk space for these components.
Opening a product entry will display the components of the particular product.
PantoneLIVE Component I Size | Destination Folder |
- ] EardogeriE PantoneLIVE 39.10MB  C:\PantoneLIVE
& PantonelIVE PantoneLIVE plug-ins for Adobe
llustrator.
Local disk free space Destination Folder
- Before | After [C:\PantoneLIVE
C: 37.74GB  37.70GB
D: 7.42GB 7.42GB Browse... Apply to Selection ] Applyto Al I
Select Al E: 1.85GB 1.85GB

F513GB 5138
Total number of products selected: 1 Desclect Al | Heb |

Help

<Back Ned> | Cancel |

© Pantone LLC, 2024 Page 6 of 33
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8. Click Next to start the installation process, then Continue to begin pre-installation.

X-Rite PantonelIVE Plug-ins for Adobe Illustrator - Installation =
5 < P
X-Rite PantoneLIVE Plug-ins for Adobe lllustrator - Installation Z “";f PantonelIVE 1.0 Plug-ins Pre-Installation
Ready to execute the following installation actions. £ Rl
F{LIVE] PantoneLIVE 1.0 Plug-ins Pre-Installation

Performing pre-installation tasks.

PANTONE"

S
C R
g E:":

The installation Wizard is ready to start the installation processs.

Check the installation operations in the window below. Click Next to start the installation process, click Back to

change the installation selections or click Cancel to abort the installation process. PantoneLIVE Plug-ins Pre-Installacion

Component Action Destination Folder
PantonelIVE INSTALL C:\PantonelIVE Searching for Adobe Illustrator CS5 installation ...
Adobe Illustrator CSS found on this system.

Searching for Adobe Illustrator CS5.5 installation ...
Adobe Illustrator CS5.5 was not found on this system.

Click 'Continue' or wait until the countdown is finished.
Click 'Wait' to interrupt the countdown.

Continuing in 2 seconds

<Back | Net> | Cancel | Wait Continue

9. Click Finish to complete the installation. The plugins are now available within Adobe
lllustrator.

10. If additional software is required to use your license subscription, you can download it
from http://www.xrite.com/product_overview.aspx?ID=1988&Action=Support.

To Download and Install on a Mac

If it is running, close Adobe lllustrator.

Visit http://www.xrite.com/product_overview.aspx?ID=1988 to download the software.
Select PantoneLIVE.dmg. The plugins will download on your computer.

When the download is complete, double-click to launch the .dmg file.

From the Finder window, double-click PantoneLIVE.mpkg to begin the installation.

o=~

0o |_| PantoneLIVE =
P 4 3 items, 1.9 MB available K
A .
PantoneLIVE.mpkg Read Me Release Notes.rtf

© Pantone LLC, 2024 Page 7 of 33
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6. When the installer begins, click Continue to install the plugins. Read the license
agreement, click Continue, then Agree.

— enN w Install Plug-ins for Adobe®
e N « Install Plug-ins for Adobe® Illustrator®
Important Information
Welcome to the Plug-ins for Adobe® Illustrator® Installer
®
Welcome to the installation program for the following © Introduction PantoneLIVE for AdObe M
© Introduction components: ® !
Read M © Read Me lllustrator |
® Read Me « PantoneLIVE Color Book 2 |
« PantoneLIVE Viewer @ Destination Select Installation Notes |
® Destination Select C |
° I
& InsEailation Tyve Installation Type ontent )
® Installation @ Installation Plug-ins for Adobe® llustrator® CS5 and CS5.5 :
® Summary ® Summary « PantoneLIVE Color Book |
* PantoneLIVE Viewer |
il.l 3 iu ) r' fi :
o Please read the Release Notes for system requirements and
2 8 al; = L latest information on this version. |
ok +# ok + Aboutili U
- s = = | | L] 5] out Licenses
= 4 This software is protected against unauthorized use. To
< LIVE g purchase a license please contact your PantoneLIVE sales
a o representative or visit www.pantone.com/live.
™ www.pantone.com/live
PREFERRED PARTNEF PR
SunChemiecal’ TR | (e mm—— SunChemical Print... Save... ) ( GoBack ) ( Continue )
s i s el p

7. Click Install and follow the wizard to complete the installation. Click Close to complete

the installation. The plugins are now available within Adobe lllustrator.
800

« Install Plug-ins for Adob:

800 & Install Plug-ins for Adobe® lllustrator®

Standard Install on “Macintosh HD”

The installation was completed successfully.

© Introduction

© Read Me
© Destination Select

© Installation Type

This will take 50.4 MB of space on your computer.

Click Install to perform a standard installation of
this software on the disk “Macintosh HD".

© Introduction
© Read Me

© Destination Select

© Installation Type
@ Installation

© Installation

The installation was successful.

® Summary
© Summary
(] ) The software was installed.
w o e =
=% ol w !
ol ¥ S5k #
= B | [ »
4 " *m
g SR =
o = (" Change Install Location... ) o

B

PREF

PREFERRED PART

N hemi . ————E— | IS aTERmT— N hemical
SunChemical (" Customize ) GoBack ) ( Install ) SunChemical Go Back Close )
i o v T e — = Smiare adlicome g

© Pantone LLC, 2024 Page 8 of 33
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Step Four: Set up the PantoneLIVE Connection
After you have installed the PantoneLIVE plugins, you can access them within Adobe
lllustrator. You must have an active internet connection to connect to PantoneLIVE.

1.
2.

Launch Adobe lllustrator.

If the “PantoneLIVE Connection Details” window does not appear, select Preferences >

PantoneLIVE.

_File Edit Object Type Select Effect View Window Help

About Illustrator...

General.. K
[ 4

. Selection & Anchor Display...
Services

Quit lllustrator  8Q Hyphenation...

| Plug-ins & Scratch Disks...
User Interface...

File Handling & Clipboard...
Appearance of Black...

PantoneLIVE | 2 PantoneLIVE Connection...

Type... R S
Hide Illustrator Un!ts... ) B IR B
Hide Others \%H Guides & Grid... - ; : :
Show A Smart Guides...

Slices...

3. Enter your My X-Rite account and password. Leave the “PantoneLIVE Server” box at

the default.

Set up your PantonelIVE Connection

Account Name: | |

Password: | |

PantonelLIVE Server: |https://ws.pantonelive.com

Check Connection @® Not connected

Synchronize Now @® Your PantoneLIVE account name and/or
password appears to be incorrect.

Your PantonelIVE connection details can be changed anytime in Preferences
> PantonelIVE

[ Cancel ) OK

© Pantone LLC, 2024
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4. If your license code was assigned to you by someone else, the code must be activated.
Click the Activate button and enter the PantoneLIVE Activation Code that you received

in the activation e-mail.

Set up your PantonelIVE Connection

Account Name: |Test ID |

Password: |....... |

PantonellVE Server: |https://ws.pantonelive.com

(Check Connection ) © Connection OK
L

this machine.

Activate your PantoneLIVE Account

Activate ) @ You PantoneLIVE account needs activation on

Please enter your PantonelLIVE Activation Code

‘' B
[ Cancel ) |

oK

\‘

5. Click Check Connection. If login is successful, “Connection OK” will appear next to a
green dot. If not, verify your PantoneLIVE Application License has been activated and
that your PantoneLIVE login is correct. See the “Getting Started” section for more

information.

Set up your PantonelLIVE Connection

Account Name: [TestID| \

Password: |---no.o--o ‘

PantoneLIVE Server: |https://ws.pantonelive.com

ek ( ectio © Connection OK

O PantonellVE Libraries are not up to date.
Please synchronize. Since synchronizing may
take some time you can synchronize later.

> PantonelIVE

Your PantoneLIVE connection details can be changed anytime in Preferences

6. From this window, you can check your connection to the PantoneLIVE server and
synchronize to obtain the latest color libraries. These options are detailed in the

“Managing PantoneLIVE Libraries” section.

© Pantone LLC, 2024
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Managing PantoneLIVE Libraries

You must have an active internet connection to connect to PantoneLIVE.

Checking Status

At the bottom of all PantoneLIVE windows, you can check the status of your connection.
o Green dot: “Connection OK”

‘ © Connection OK ‘

o Yellow dot: “Update Required” — Follow the steps in this section to Update PantoneLIVE

Libraries.

‘ () Update required ‘

* Red dot: “Not Connected” — Follow the steps in this section to Check Connection to the

PantoneLIVE Server.

@® Not connected

Checking Connection to the PantoneLIVE Server
If you receive a red status dot when you launch Adobe lllustrator, or in any PantoneLIVE dialog,
this means that you are not connected to the PantoneLIVE server; possibly because you are not
connected to the internet, or there may be a problem with your user name or password.

To re-connect:

1. Select Preferences > PantoneLIVE > PantoneLIVE Connection.

[ lllustrator

Object Type Select Effect View Window Help

About lllustrator...

Services

Hide lllustrator
Hide Others "\ #H

Quit lllustrator  $Q

PantoneLIVE | 2

Ceneral... 8K
Selection & Anchor Display...

Type...
Units... 8, FE
Guides & Grid...

Smart Guides...

Slices...

Hyphenation...

Plug-ins & Scratch Disks...
User Interface...

File Handling & Clipboard...
Appearance of Black...

PantonelIVE Connection...

© Pantone LLC, 2024
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2. Enter your Account Name and Password and click the Check Connection button.

Set up your PantonéLl\;E tonnection

Account Name: | I

Password: | |

PantoneLIVE Server: [https://ws.pantonelive.com

Check Connection @® Not connected

Synchronize Now @® Your PantonelLIVE account name and/or
password appears to be incorrect.

Your PantonelLIVE connection details can be changed anytime in Preferences
> PantoneLIVE

— ¢
[ Cancel ) OK
S——————

3. If you are still unable to connect, check your internet connection and verify your
PantoneLIVE login and Partner Access permissions are correct. See the “Getting Started”
section for more information.

Updating PantoneLIVE Libraries
Each time you launch Adobe lllustrator, it will check to see if there are updates available for your

licensed library palettes. The status is available in all PantoneLIVE related dialogs. If the status
dot is not green, follow these steps to perform updates.

1. Select Preferences > PantoneLIVE > PantoneLIVE Connection.
[Vlllustrétor File Edit Object Type Select Effect View Window Help
About lllustrator...

General... 38K
. Selection & Anchor Display...
Services Type... r—— —
Hide Illustrator Units... P
Hide Others " %H Guides & Grid... [ : : :
Show A Smart Guides...
Slices...

Quit lllustrator $Q Hyphenation...

' Plug-ins & Scratch Disks...
User Interface...

File Handling & Clipboard...
Appearance of Black...

PantoneLIVE 3 PantonelIVE Connection...

© Pantone LLC, 2024 Page 12 of 33
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2. If the message indicates your PantoneLIVE Libraries are not up to date, click the
Synchronize Now button. Depending on the number of updates, this can be a slow

process, so it is best to do this during a slow period when time allows.

V ‘Set up your PantoneLIVE Connection

Account Name: |TestID

|

Password: [sesssecece

PantoneLIVE Server: |https://ws.pantonelive.com

Ne—

(Check Connection) © Connection OK

Synchronize Now © PantoneLIVE Libraries are not up to date.
Please synchronize. Since synchronizing may
take some time you can synchronize later.

> PantoneLIVE

a——"
[ Cancel )

Your PantoneLIVE connection details can be changed anytime in Preferences

3. Select the PantoneLIVE libraries that you would like to sync. If you would like to sync all,
click the box next to “Library”.

PantoneLIVE Libraries Synchronization

List of PantoneLIVE Libraries:

\ ™ | Library ~| Status |
™ " PANTONE+ Color Bridge ... &3 Not downloaded yet 0
™ 4 PANTONE+ Complete Co... &3 Not downloaded yet
M |_ PANTONE+ Corr;plete Unc... & Not downloaded ;'et
™ 4 PANTONE+ Extended Coa... &3 Not downloaded yet
[Z[ 1’ PANTONE+ Extended Unc... & Not downloaded yet
™ 4 PANTONE+ Pastels & Neo... & Not downloaded yet
[Zl 1’ PANTONE+ Pastels & Neo... & Not downloaded yet
™ 4 PANTONE+ Solid Coated &3 Not downloaded yet :

Select PantoneLIVE Libraries to Synchronize

| A——T——
[ Close )
Sse——

4. Click Synchronize. Depending on the number of libraries to sync, this process can take
a while. Be sure to allow extra time.

5. When finished, click Close. Your PantoneLIVE Libraries are now up to date.

(Check Connection) © Connection OK

Synchronize Now © PantonelLlVE Libraries are up to date.

© Pantone LLC, 2024
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Managing Colors in Adobe lllustrator

When you have a layout open in lllustrator, you can:

Check Status

Add a color from a PantoneLIVE library

Replace a color in your library or layout with a color from a PantoneLIVE library
Delete an unused color

IMPORTANT: In order to use the PantoneLIVE plugins, your file must be in a CMYK working
space. If your file is in an RGB working space, all options will be gray.

Adding a Color from a Library
To add a color from a PantoneLIVE library to your library or layout:

1. With your layout or library open in lllustrator, select Window > PantoneLIVE > Color
Book > Add Color from Library.

| Window T IN15s @ O ™ H = = <) @F36% Mon 10:24
e Wi = T —
Arrange > |
Workspace > '

Extensions > i ‘»E
B
Application Frame [~3

v Application Bar 1;:

v Control E

v Tools
Actions
Align oF7 |
Appearance 0F6 Py
Artboards
Attributes #F11
Brushes F5
Color F6
Color Guide 0F3
Document Info
Flattener Preview
Cradient 3#Fo m
Craphic Styles 0F5
Info 38F8 r
Layers F7 §

Links L

Magic Wand !

Navigator !

PantoneLIVE Color Book > Add Color from Library...
Pathfinder {0 88F9 Color Manager Replace Color...
Separations Preview Viewer > | l ’T

© Pantone LLC, 2024 Page 14 of 33
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2. Select the color you wish to add and click Add. If the search box is not available in the
upper right hand corner, you may need to increase the size of the dialog box.

Add Color from Library

Choose From L- PANTONE+ Complete Coated (Formula Guide with Pastels and Neons and 336 Colors)

P;

PANTONE 100 C PARTONE 105 C PANTONE 110 C

PANTONE 101 C

PANTONE 106 C PANTONE 111 C

PANTONE 102 C

PANTONE 103 C

PANTONE 104 C

PANTONE 107 C PANTONE 112 C

PANTONE 108 C PANTONE 113 C

PANTONE 109 C PANTONE 114 C

(=)
© Connection OK

Add

Page 2
PANTONE 115C  PANTONE 1205 C
PANTONE 116 C  PANTONE 120 C
PANTONE 117 C PANTONE 1215 C
PANTONE 118 C PANTONE 121 C

PANTONE 119 C PANTONE 1225 C

PANTONE 122 C
PANTONE 1235 C
PANTONE 123 C

PANTONE 1245 C

PANTONE 124 C

}-e-i Find Colors o »

PANTONE 1255C |

PANTONE 125 C

PANTONE 1265 C

PANTONE 126 C

|
|
|

PANTONE 127 C

SWATCHES

FRIEAEIEEERE

3. The new color will appear in your swatch library under the Library name.

© Pantone LLC, 2024
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Replacing a Color
To select a color from your library or layout and replace it with a color from a PantoneLIVE
palette:
1. With your layout or library open in lllustrator, select Window > PantoneLIVE > Color
Book > Replace Color.

[ Window TR Nis @ O ™M 5 = = <) EFaoow Sun9:52
feNncow O] —
Arrange | =
Workspace > '

Extensions > L

Application Frame
v Application Bar

v Control
v Tools
Actions
Align OF7
Appearance {F6
Artboards
Attributes 38F11
Brushes F5
Color F6
Color Guide {0F3
Document Info
Flattener Preview
Cradient 38F9
Graphic Styles {QF5
Info 38F8
Layers F7
Links A
Magic Wand ET;
Navigator e
PantoneLIVE > Color Book > Add Color from Library...
Pathfinder 0 38F9 Color Manager Replace Color...
Separations Preview Viewer >

2. Inthe “Replace Selected Color by” drop-down, select one of the following:
o A Document Color
o+ CMYK Color
o Find Best Match
o Color From Library
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A Document Color

A Document Color allows you to select an ink from the document inks.

Replace Color

Current Colors

Replace Selected Color by | A Document Color |4 j

© Connection OK

Replace Color

9 ::Ig:i : [] PANTONE 375 C
[] PANTONE [ PANTONE 377 C
I PANTONE & [] PANTONE 388 C
[ PANTONE & [ PANTONE 7690 C
Bl oot 8lack [IT] PANTONE 7737 C

. Spot Black
Details:

# Hide unused colors

CMYK Color

CMYK Color allows you to convert the selected ink into its CMYK equivalent. The CMYK

values that will be used are shown underneath.

Replace Color

Current Colors

Replace Selected Color by | CMYK Color

A
v

© Connection OK

Replace Color

[ ] PANTONE g
[ PANTONE g
[ ] PANTONE g
[ PANTONE g
[] PANTONE g
. Spot Black . e
yan: 0.
Magenta: 0.0%
Yellow: 0.0%
Black: 0.0%
Details:

© Pantone LLC, 2024

Page 17 of 33



PantoneLIVE Plugins for Adobe® lllustrator® User Manual

ai I
"
|

LIVE}

SunChemical

PANTONE

Find Best Match

Find Best Match will scan the selected Ink Book and list the inks with the lowest dE compared
to the ink you want to replace.

Replace Color
Current Colors Replace Selected Color by | Find Best Match -4
[[] PANTONE g
. PANTONE g Library: | ;s PANTONE+ Complete Coated (Formula Guide with Pastels and Neons and 336 Colors) 4
D PANTONE  § dE Formula: [ CIELAB Delta E (Classic) | &
[ PANTONE g
. PANTONE g dE Ink Name
. Spot Black
Details:
New dE

Current

© Connection OK
Replace Color

1. Select the current color on the left. A list will appear on the right that shows the closest
colors with each associated dE.
2. Select a new ink on the right. In the bottom panel of the window, the current and new

Replace Selected Color by | Find Best Match [ ]

Library: | 'y PANTONE+ Complete Coated (Formula Guide with Pastels and Neons and 336 Colors)

?]

dE Formula: [ CIELAB Delta E (Classic) |4

Ink Name
[] PANTONE 375 C
[[] PANTONE 2290 C

8.41 [ PANTONE 2286 C

[C] PANTONE 2292 C
[ PANTONE 2293 C
[T] PANTONE 376 C

[C] PANTONE 2291 C
[C] PANTONE 2297 C
[C] PANTONE 2299 €
[ PANTONE 368 C

New dE 8.41

Current

inks appear side by side.
Replace Color
Current Colors
[E PANTONE 377 C v
[[] pANTONE 388 C L
[ PANTONE 7690 C I
[ PANTONE 7737 C I b
. Spot Black 0.00
7.71
9.40
Details: 22
9.95
11.48
PANTONE 375 C
B 14.29
Library: PANTONE+ Complete Coated (Formula Guide with Pastels and Neons and 336 Colors) 14.31
[t 16.87
Wegof
LY -
|
=
F{LIVE]
© Connection OK
Replace Color

3. Click Replace Color. The new color will replace the old one in the Ink Library.

© Pantone LLC, 2024
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Color from Library

Color from Library allows you to replace an ink with a new ink from a Library.

Replace Color

Current Colors

[X] PANTONE 377 C
[[] pANTONE 388 C
[ PANTONE 7690 C
[E PANTONE 7737 C
Il spot Black

(L Ly

Details:

[] PANTONE 375 C

Library: PANTONE+ Complete Coated (Formula Guide with Pastels and Neons and 336 Colors)

© Connection OK

Replace Color

Replace Selected Color by | Color from Library B

W PANTONE+ Extended Coated (Formula Guide with 336 Colors)
W PANTONE+ Solid Uncoated
" PANTONE + Solid Uncoated-336

Page 1

W PANTONE+ Complete Uncoated (Formula Guide with Pastels and Neons and 336 Colors)
" PANTONE + Extended Uncoated (Formula Guide with 336 Colors)

W PANTONE+ Solid Coated-336

" PANTONE + Pastels & Neons Uncoated

" PANTONE + Solid Coated

1 PANTONE + Pastels & Neons Coated

PANTONE 1( s PANTONE+ Color Bridge Coated

PANTONE 103 C

PANTONE 1( NE 122

PANTONE 1( NE 1235

NE 123 ¢

PANTONE 108 C PANTONE 113 C PANTONE 118 C PANTONE 121 C PANTONE 1245

PANTONE 104 C PANTONE 109 C PANTONE 114 C PANTONE 119 C PANTONE 1225 C  PANTONE 124 ¢

N —

additional swatches.

2l

Click Done.

Hide Unused Colors

All synced libraries will appear under the “Choose From” pull-down.
Select the library you wish to access. The scroll-bar across the bottom will display

On the left side of the screen, click the color you wish to replace.
On the right side of the screen, click to select the new color.
Click Replace Color. The new color will appear in the list with the PantoneLIVE logo.

Mark the “Hide unused colors” box to hide colors you are not currently using in your layout.

Replace Color Replace Color
Current Colors Replace Selected Color by [ A Document Color |4 Current Colors Replace Selected Color by [ A Document Color |4 ]
PANTONE PANTONE
U = Process Cyan O = [ PANTONE 375 C
[ PANTONE [ PANTONE '
D PANTONE - Process Magenta D PANTONE - PANTONE 377 C
. PANTONE : D Process Yellow . ANTONE : ‘:l PANTONE 388 C
Process Black PANTONE 7690 C

[ PANTONE u PANTONE g |
Il svot Black [] PANTONE 375 C Il svot Black PANTONE 7737 C

[ PANTONE 377 C [l Soot Black

[] PANTONE 388 C

[ PANTONE 7690 C

[ PANTONE 7737 C

. Spot Black
Details: Details:

[_J Hide unused colors X # Hide unused colors
© Connection OK © Connection OK

Replace Color

Replace Color

© Pantone LLC, 2024
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PANTONE

PantoneLIVE Color Manager
PantoneLIVE Color Manager gives you a quick overview of the colors in your document.

From here you can:
o See whether your colors have all been mapped to PantoneLIVE
+ See from which libraries your colors originated.
* Change the order of the colors manually, sort light to dark, etc. This affects the way the
preview is made in the PantoneLIVE viewer.

1. With your layout or library open in Illustrator, select Window > PantoneLIVE > Color
Manager. The PantoneLIVE Color Manager window will launch.

PANTONELIVE COLOR MANAGER

Color Name Type Library

1 . PANTONE 769... Normal PANTONE+ Complete Coated (For...

2 El PANTONE 388 C Normal PANTONE+ Complete Coated (For...

3 - PANTONE 377 C Normal PANTONE+ Complete Coated (For...

4 I:I PANTONE 375 C Normal PANTONE+ Complete Coated (For...

S . PANTONE 773... Normal PANTONE+ Complete Coated (For...

6 . Spot Black Normal

Base Colors: 6 L@ ([ LT[0 +h]

2. Click the list icon in the upper right corner to access the options.

PANTONELIVE COLOR MANAGER Color Det

Color Name Type Library
1 [l rPanTONE 769... Normal Convert Color to...
2 [] ranTONE 388 C Normal Convert Color to CMYK
3 [ ranTONE 377 C Normal Convert all Spot Colors to CMYK
4 PANTONE 375 C Normal 5
L] Update Color List
s [l PanTONE 773... Normal
¢ [l sectsacc  Norma Reverse Color Order

Save CMYK Color Order as Default
Restore Default CMYK Order

Sort Light To Dark

Sort Dark To Light

Base Colors: 6 I i rl g [ i l—] "E” ‘*R” :'Eil'— »
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Using the PantoneLIVE Viewer

Generating the Viewer
The PantoneLIVE Viewer gives a more accurate soft proof than lllustrator alone because it

considers your profile and printing substrate. It shows how the colors will appear on your selected
substrate.

To use the Viewer, you must generate a preview of the current document based on your specific
Press Settings.

1. Select Window > PantoneLIVE > Viewer > Generate. The PantoneLIVE Viewer will

appear.
PANTONELIVE VIEWER
r ' = "I _
[ Window [T [rosss BARGE - WoN RO R N h ' ..
New Window | EsseniaLsv | (8] ced at z
Arrange | =
o sacn > [&E _ oneLIVE, <
Extensions > L Ire I’e,
Application Frame nical Inks and n T
Application B
i technology.
v Tools -
Actions ® .
N\ . D
Aligh Iy 1l e xrite w = Real color, on real sui strate
Appearance {6 =z -
Artboards E] PANTONE®
Attributes #®F11 “STNER E ‘ ‘.
Brushes 3 =
Color 76 qm
Color Guide 0F3 |7 o
Document Info “ Chesapeake
Flattener Preview
Gradient #8F9 m
Graphic Styles QFs5
Info ®F8
Layers F7
Links
Magic Wand
Navigator
ColorBook >
Pathfinder 089 Color Manager
Separations Preview Viewer > Generate i | S ——
S - [ & | () Update required |Dot Gain Curve: | Automatic jE 150% j.@ __ Generate

2. When you make changes to the document, the Generate button will change to an
Update button. Click it to render a new Viewer preview.
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Using the Viewer
The Viewer window shows a preview of your document. To access the viewer, select Window
> PantoneLIVE > Viewer > Viewer.

At the bottom of the palette, you will find:
o A connection status. See the “Checking Status” section for more information.

¢ A zoom-in and zoom-out button

o A drop-down menu with several zoom percentages and two extra zoom factors: Fit
Artboard and Fit Graphics.

o Dot Gain Curve drop-down, which we’ll cover in the next section.

w
L S r
# 5 . :
<) :
= ' 5 800%
Qi snapmices M) Z to =
peake toneLIVE, o
Esko prepr viare. < L Iv :gg%
Sun Chemical Inks and D. v 150%
X-Rite technology. 100%
= - p e .
SunChenrieal Wexrite W Real coor, ar real s )re re 0%
- ANTONE Zaih - | mam i
e hemical Inks € :-
Ruve <
ESKO® gl chesapeake it X

back

[ & | © Comection ok | ot Gain Curve: [(Automaric 13- [[ 200 18 [+ ]

o A Lock Screen tool that allows you to lock or unlock the screen without adjusting the
position of the piece.

- |[ 200% Qm@ -|[1oox ’

“ar

Dot Gain Settings

The dot gain setting is used to give the preview a more representative look based on specific
dot gain to be expected on the press/proofer that is being previewed. Auto takes the dot gain of
the default ICC profile in color settings.
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To enter custom dot gain settings:
1. From the PantoneLIVE Viewer, click the arrow drop down in the upper right corner of

the window and select Dot Gain Settings.

PANTONELIVE VIEWER

r"

Dot Gain Settings...

2. A “Dot Gain Settings” window will appear.

Dot Gain Settings

”Copy

"~ Edit ...

Remove

[ Close

3. Click New. Enter a name and percentages for Minimum, 25%, 50%, 75%, and

Maximum dot.

New Dot Gain Settings

Edit Dot Gain Settings

Name: |Untitled

Name: Box Demo

Minimum dot [0 %
25 % prints as |25 %
50 % prints as |50 %
75 % prints as ,ﬁ %
Maximum dot |100 %

CCancel) ( Save )

Minimum dot |0 %

25 % prints as |37 %
50 % prints as |68 %
75 % prints as |87—| %
Maximum dot |100 %

(Cancel) ( Save )

© Pantone LLC, 2024
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4. Click Save. The new Dot Gain Settings will appear in the Dot Gain Settings box. You
can edit these settings by clicking the Edit ... button.

Box Dero
5. In the future, this custom Dot Gain Setting can be selected from the “Viewer” drop-
down.
PANTONELIVE VIEWER
>

1) e xrite . Real color, on real substrate
c] y wa’ only a click away.

PANTONE® :

“STNER

ﬁ Chesapeake

[ & | () Update required | Dot Gain g
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Help and Troubleshooting

When you encounter an issue with the PantoneLIVE plugins, it may be difficult to determine
whether it is a problem with Adobe lllustrator or the PantoneLIVE plugins, or color management
is the culprit. This section can provide a first line resource for troubleshooting common errors.

Resource One: Adobe lllustrator Help

If you encounter an issue, start by access the help file within Adobe lllustrator. Select Help >
lllustrator Help and search for a resolution.

Resource Two: Color Management
If you determine the issue is not within lllustrator, you may be experiencing a color management
issue.

X-Rite Color Services offers a variety of classroom, seminar, and eLearning options to help you
color manage your devices and workflow. Visit http://www.xrite.com and click on Training
Services for more information.

Resource Three: PantoneLIVE Plugins Help
Help is available on the installed PantoneLIVE plugins. From Adobe lllustrator, select Help >
PantoneLIVE > PantoneLIVE Help to access the online help files.

Here are a couple of common plugin issues and resolutions.

Issue: All of my PantoneLIVE plugin options are gray.
Resolution: In order to use the PantoneLIVE plugins, your file must be in a CMYK working
space. Please ensure you are using a CMYK working space, not RGB.

Issue: | cannot connect to PantoneLIVE through Adobe lllustrator.
Resolution: Ensure your PantoneLIVE Application License has been claimed and activated,
and that your PantoneLIVE login is correct. See the “Getting Started” section for more informatio
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Legal Notices

This product includes Izw-ab.
Copyright (c) David Bryant
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the

documentation and/or other materials provided with the distribution.

* Neither the name of Conifer Software nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes curl.

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1996 - 2024, Daniel Stenberg, <daniel@haxx.se>, and many
contributors, see the THANKS file.

All rights reserved.
Permission to use, copy, modify, and distribute this software for any purpose

with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO
EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

This product includes FreeType.

Portions of this software are copyright (C) 2014 The FreeType
Project (www.freetype.org) licensed under the Freetype License.
All rights reserved.

This product includes OpenSSL.

Apache License
Version 2.0, January 2004
https://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as
defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized bythe copyright owner that
is granting the License.

“"Legal Entity" shall mean the union of the acting entity and all other entities that control,
are controlled by, or are under common control with that entity. For the purposes of this
definition, “control" means (i) the power, direct or indirect, to cause the direction or
management of such entity, whether by contract or otherwise, or (ii) ownership of fifty
percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such
entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted
by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
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software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a
Source form, including but not limited to compiled object code, generated documentation, and
conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available
under the License, as indicated by a copyright notice that is included in or attached to the work
(an example is provided in the Appendix below). "Derivative Works" shall mean any work,
whether in Source or Object form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an
original work of authorship. For the purposes of this License, Derivative Works shall not include
works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work
and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and
any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal
Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition,
"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or
its representatives, including but not limited to communication on electronic mailing lists, source
code control systems, and issue tracking systems that are managed by, or on behalf of, the
Licensor for the purpose of discussing and improving the Work, but excluding communication that
is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a
Contribution has been received by Licensor and subsequently incorporated within the Work.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright
license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and
distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such Contributor
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with
the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated
within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to
You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any
medium, with or without modifications, and in Source or Object form, provided that You meet the following
conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
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(b) You must cause any modified files to carry prominent noticesstating that You changed the files;
and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different
license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such
Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise
complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this
License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall
supersede or modify the terms of any separate license agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the
Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT WARRANTIES
OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties
or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR
PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts)
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect,
special, incidental, or consequential damages of any character arising as a result of this License or out of
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if
such Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,

You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations, You
may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor,
and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred
by, or claims asserted against, such Contributor by reason of your accepting any such warranty or
additional liability.

END OF TERMS AND CONDITIONS

This product includes PantoneLIVE.

PANTONE® Colors displayed here may not match PANTONE-identified standards. Consult current
PANTONE® Color Publications for accurate color.PANTONE®, PantoneLIVE and other Pantone
trademarks are the property of Pantone LLC.

Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2024.

This product includes Qt.

The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2024 The Qt Company
Ltd.

Portions of this software are copyright (C) 2006-2023 The FreeType Project (www.freetype.org). All rights
reserved.

Copyright (C) 1991-2020, Thomas G. Lane, Guido Vollbeding. This software is based in part on
the work of the Independent JPEG Group.

Secure Hash Algorithm SHA-3 - brg_endian
Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

LICENSE TERMS

The redistribution and use of this software (with or without changes) is allowed without the payment of
fees or royalties provided that:

1. source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;

2. binary distributions include the above copyright notice, this list
of conditions and the following disclaimer in their documentation;

3. the name of the copyright holder is not used to endorse products
built using this software without specific written permission.
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DISCLAIMER

This software is provided 'as is' with no explicit or implied warranties
in respect of its properties, including, but not limited to, correctness
and/or fitness for purpose.

This product includes QtSingleApplication.

Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
Contact: http://www.qt-project.org/legal

This file is part of the Qt Solutions component.
You may use this file under the terms of the BSD license as follows:

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:
Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes QtSvg.
Copyright (C) 2024 The Qt Company Ltd.

Copyright2002 USC/Information Sciences Institute
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Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that the above copyright notice appear in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
Information Sciences Institute not be used in advertising or publicity pertaining to distribution of the
software without specific, written prior permission.Information Sciences Institute makes no
representations about the suitability of this software for any purpose.lt is provided "as is" without express
or implied warranty.

INFORMATION SCIENCES INSTITUTE DISCLAIMS ALL WARRANTIES WITH REGARD
TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL INFORMATION SCIENCES
INSTITUTE BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL

DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA
OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this case for the
Apache Xerces distribution.

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following: software copyright (c) 1999, IBM
Corporation., http://www.ibm.com.
This product includes XMP Toolkit.

Copyright (c) 2020, Adobe
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes zlib.

(C) 1995-2013 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied warranty. In no event will the authors be
held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the
original software. If you use this software in a product, an acknowledgment in the product
documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as
being the original software.

3. This notice may not be removed or altered from any source distribution.

Updated 04 November 2024
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